Issues

# Project Tracker Status Priority Subject Assignee Updated

5838 Kepler Bug Works For Me Normal incomplete transfer of error messages into serialized WorkflowRun xml Derik Barseghian 04/08/2013 02:38 PM

5790 Kepler Bug Resolved Normal Not all remote run-kars appear in Workflow Run Manager Derik Barseghian 01/29/2013 02:41 PM

5789 Kepler Bug Resolved Normal component tree disappears after clicking Clear after downloading KAR Daniel Crawl 01/23/2013 01:50 PM

5782 Kepler Bug Resolved Normal wrong behavior when trying to Export a run when module dependencies not Derik Barseghian 01/15/2013 01:40 PM
satisfied

5781 Kepler Bug Resolved Normal opening a workflow run leaves temp kar entry in Recent Files menu and changes Derik Barseghian 01/15/2013 01:41 PM
last directory setting

5778 Kepler Bug Resolved Normal Force Open doesn't (always?) currently work with Workflow Run Manager Derik Barseghian 01/15/2013 01:39 PM

5754 Kepler Bug Closed Normal unable to open TestSSHWithDisplay 2.3 run-kar from keplerRepository with WRM [ Derik Barseghian 11/30/2012 02:06 PM
trunk

5732 Kepler Bug Resolved Normal EML 2.1.1 option should be added to metacat data sources in kepler Jing Tao 11/27/2012 04:45 PM

5725 Kepler Bug Resolved Normal Save dialog's folder drop-down menu crashes kepler in OS X 10.8 w/ 64-bit java Derik Barseghian 03/14/2013 10:09 AM
1.6.0_37-b06-434-11M3909

5724 Kepler Bug New Normal Display actor's suppressBlankLines parameter not working Derik Barseghian 10/22/2012 05:55 PM

5722 Kepler Bug Resolved Normal Check for problems with sanitized RecordToken labels Daniel Crawl 08/14/2015 04:18 PM

5720 Kepler Feature Resolved Normal Kepler component documentation layout needs improvement Daniel Crawl 09/11/2015 09:38 AM

5719 Kepler Bug Resolved Normal parameter values no longer appear on canvas Derik Barseghian 10/01/2012 06:13 PM

5716 Kepler Bug Resolved Normal Module Manager should only print Downloading messages when actually Daniel Crawl 08/16/2015 07:02 PM
downloading

5712 Kepler Bug Resolved Normal illegal option chmod error during Kepler startup Derik Barseghian 10/30/2012 03:46 PM

5711 Kepler Bug Resolved Normal post release process cheatsheet Derik Barseghian 10/02/2012 12:39 PM

5703 Kepler Bug Resolved Normal GUI bug - Deleting an Actor with connected port causes a diamond relation to be Christopher Brooks 09/07/2012 10:27 AM
created.

5702 Kepler Bug Resolved Normal GUI bug - Initial actor port positioning is wrong Derik Barseghian 09/07/2012 11:08 AM

5701 Kepler Bug Resolved Normal CT was removed, demo workflows need to be updated Daniel Crawl 09/14/2012 09:22 PM

5700 Kepler Bug Resolved Normal after getting an actors patch, actor changes won't be visible to user until .kepler is Daniel Crawl 03/07/2013 02:24 PM
removed

5697 Kepler Bug New Normal Workflow Run Manager can fail to Force Open a run kar that Kepler can Derik Barseghian 11/30/2012 02:06 PM

5693 Kepler Bug New Normal decide on issuing patches so older versions of kepler can upload accessible items [ Jing Tao 08/23/2012 12:41 PM
to Metacats > 2.0

5690 Kepler Bug New Normal problems with updateActorDocs Daniel Crawl 09/18/2012 12:45 PM

5688 Kepler Bug Resolved Normal library not working in kepler trunk in windows7 Derik Barseghian 09/07/2012 11:03 AM

5686 Kepler Bug New Normal datasets produced by archiveDataturbineDataToMetacat workflow show samples Derik Barseghian 08/30/2012 05:34 PM
'sliding’ in time

5685 Kepler Bug New Normal data isn't always chunked properly Derik Barseghian 08/30/2012 05:34 PM
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5684 Kepler Bug Resolved Normal Add warning to archiving workflow that it must be run on one machine to not Derik Barseghian 08/30/2012 06:09 PM
produce overlapping datasets
5683 Kepler Bug Resolved Normal archiveDataturbineDataToMetacat.kar can fail with an IOException on win7 and XP |Jing Tao 08/30/2012 05:57 PM
5681 Kepler Bug Resolved Normal Tracking bug for sensor-view-0.9.0 release testing Derik Barseghian 08/30/2012 09:37 PM
5680 Kepler Bug Resolved Normal after inline save, demo workflow disappears from tree Daniel Crawl 09/17/2012 06:03 PM
5679 Kepler Bug In Progress Normal the workflows in sensor-view should be resaved beneath sensor-view-0.9.0 so Derik Barseghian 08/30/2012 05:34 PM
users aren't prompted to force open them
5675 Kepler Bug New Normal new ProgressMeter demo workflows give errors when opening in sensor-view-0.9.0 | Derik Barseghian 08/30/2012 05:34 PM
5674 Kepler Bug New Normal The patch downloader dialog can fail to automatically restart Kepler Derik Barseghian 08/16/2012 03:10 PM
5673 Kepler Bug New Normal if user has newer version of module than exists in repository, old version will be Derik Barseghian 08/10/2012 04:44 PM
downloaded
5672 Kepler Bug New Normal java -jar sensorview-utils-1.0.jar should invoke a simple java app that prints help Derik Barseghian 08/10/2012 03:53 PM
5671 Kepler Bug New Normal Workflow Run Manager tries to connect to keplerDevRepository as a database Derik Barseghian 08/10/2012 01:18 PM
instead of kar store
5670 Kepler Bug New Normal see if runtimemonitor module can be deleted, contains duplicate code Derik Barseghian 08/10/2012 12:01 PM
5669 Kepler Bug Resolved High replace ProjectLocator.findKeplerModulesDir() with something more robust. Daniel Crawl 08/30/2015 04:11 PM
5641 Kepler Bug New Normal once timezones are added to provenance, Workflow Run Manager must utilize them | Derik Barseghian 07/18/2012 01:14 PM
5640 Kepler Bug New Normal associate timezones with all timestamps recorded in provenance tables Daniel Crawl 07/18/2012 01:14 PM
5639 Kepler Bug New Normal ant update ptolemy -Drev=stable doesn't update you to latest "stable" Derik Barseghian 07/16/2012 12:59 PM
5638 Kepler Bug Resolved Normal "Ok" behavior of Use Module Manager prompt doesn't do what it should when Derik Barseghian 07/13/2012 10:58 AM
opening from Recent Files
5636 Kepler Bug Resolved Normal outreach/demos/Database/Database_example_1.xml workflow fails jianwu jianwu 06/27/2012 04:47 PM
5635 Kepler Bug Resolved Normal build-area should have a licenses.txt jilanwu jianwu 06/27/2012 04:38 PM
5632 Kepler Bug New Normal Runtimemonitor token count idicator placement needs improvement Derik Barseghian 06/22/2012 01:41 PM
5631 Kepler Bug New Normal PortParameters cannot be drag-instantiated from Outline/ltems of Interest trees Derik Barseghian 06/19/2012 01:23 PM
5630 Kepler Bug New Normal See about removing one set of ColorTableCellEditor and ColorTableCellRender Derik Barseghian 06/18/2012 03:45 PM
classes
5628 Kepler Bug New Normal possible to get NPE when right-clicking on kar in Components tree Derik Barseghian 06/15/2012 04:25 PM
5627 Kepler Bug New Normal List all possible port types in actor Types drop down list Derik Barseghian 06/15/2012 08:00 PM
5623 Kepler Bug Resolved Normal Outline tab context menu problems Daniel Crawl 06/15/2012 04:02 PM
5610 Kepler Bug Resolved Normal check that build system can handle a "0.9.0" release Derik Barseghian 06/22/2012 05:20 PM
5606 Kepler Bug Resolved Normal move plotting classes to sensor-view Derik Barseghian 06/18/2012 07:02 PM
5602 Kepler Bug Resolved Normal Timezone confusion using the scheduler Jing Tao 08/14/2012 06:33 PM
5601 Kepler Bug Closed Normal Can still lose report design when saving to KAR Derik Barseghian 04/02/2013 11:06 AM
5600 Kepler Bug New Normal Import Site Layout performance is poor for many connections at once Derik Barseghian 05/07/2012 04:11 PM
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5598 Kepler Bug Resolved Normal parameters appear as white boxes instead of dots Daniel Crawl 11/30/2012 04:10 PM
5594 Kepler Bug New Normal use input and output port icons in ltems of Interest Derik Barseghian 04/28/2012 04:29 PM
5593 Kepler Bug New Normal use setDefaultWidth in actors Derik Barseghian 04/28/2012 03:05 PM
5592 Kepler Bug Resolved Normal Site Layout DE Director missing documentation Derik Barseghian 06/13/2012 07:08 PM
5591 Kepler Bug New Normal Workflow Run Manager error downloading run for which module dependencies not | Derik Barseghian 04/28/2012 10:45 AM

satisfied
5590 Kepler Bug New Normal RExpression forces pdf if ‘automatically show graphics' is checked ben leinfelder 08/21/2015 04:16 PM
5589 Kepler Bug Resolved Normal Add missing ptolemy actors to library Daniel Crawl 07/27/2012 05:37 PM
5588 Kepler Bug Resolved Normal Enter and Tab behavior has changed in parameter configuration dialog Daniel Crawl 08/24/2012 01:02 PM
5585 Kepler Bug New Normal Add date format E MMM d HH:mm:ss zzz yyyy to DateToString Derik Barseghian 04/11/2012 03:55 PM
5584 Kepler Bug New Normal Create a Date To Long actor Derik Barseghian 04/11/2012 03:50 PM
5583 Kepler Bug New Normal Sensor Simulator controllable through Kepler Derik Barseghian 08/30/2012 06:03 PM
5582 Kepler Bug New Normal DataTurbine server crashing the JRE Derik Barseghian 07/27/2012 04:06 PM
5581 Kepler Bug New Normal Make Ul improvements to Components Download Derik Barseghian 08/19/2015 10:41 AM
5580 Kepler Bug Resolved Normal create sensor-view module documentation Derik Barseghian 08/03/2012 02:05 PM
5579 Kepler Bug Resolved Normal Upload to Repository on actors doesn't work Derik Barseghian 06/15/2012 11:41 AM
5577 Kepler Bug New Normal EML 2 Dataset actor EML File and Data File parameters should accept URLs Jing Tao 08/19/2015 10:39 AM
5573 Kepler Bug Resolved Normal remove ptolemy vendors/ Christopher Brooks 03/07/2013 02:25 PM
5571 Kepler Bug Resolved Normal user request: show execution time in runtime window Christopher Brooks 06/15/2012 02:23 PM
5565 Kepler Bug Resolved Normal deal with licensing for oracle jar in core Daniel Crawl 06/15/2012 02:30 PM
5552 Kepler Bug Resolved Normal Workflow Scheduler GUI needs a licenses.txt file Jing Tao 12/21/2011 02:26 PM
5549 Kepler Bug Resolved Normal Help=>Modules Documentation not working in ubuntu Derik Barseghian 11/21/2011 05:15 PM
5546 Kepler Bug Resolved Normal SDF director iterations parameter default of 0 is unfriendly Christopher Brooks 08/15/2012 07:15 AM
5545 Kepler Bug Resolved Normal Configure Ports dialog Type column gui annoyances Derik Barseghian 06/15/2012 03:54 PM
5540 Kepler Bug Resolved Normal Automate Layout no longer uses Kieler on trunk Derik Barseghian 05/01/2012 08:49 PM
5510 Kepler Bug New Normal On Ubuntu, Kepler can disappear from the dock while still running Derik Barseghian 08/19/2015 10:47 AM
5500 Kepler Bug Resolved Normal unable to open kar in relaxed mode saved in patched 2.2.0 in 2.3.0 Derik Barseghian 09/30/2011 10:03 PM
5498 Kepler Bug Resolved Normal Issue a patch for ptolemy classpath problem in kepler-2.2 Derik Barseghian 06/15/2012 11:47 AM
5496 Kepler Bug Resolved Normal non-English (United State) OS locale causes File menu and button text to not show | Daniel Crawl 09/27/2011 04:42 PM
5495 Kepler Bug Resolved Normal released kepler should allow getting patches and changing suites from command jianwu jianwu 08/08/2012 03:47 PM
line

5494 Kepler Bug Resolved Normal existence of remote 2.2 patches can cause 2.3 to fail to start 2.2 on first attempt Derik Barseghian 09/22/2011 06:45 PM
5489 Kepler Bug Resolved Normal Module Manager GUI should fail gracefully if a remote module cannot be Derik Barseghian 09/19/2012 04:18 PM

downloaded
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5487 Kepler Bug Resolved Normal blank modules.txt files created for non-suite modules jianwu jianwu 03/11/2013 11:51 AM
5485 Kepler Bug Resolved Normal standalone Module Manager can break Kepler app ability to startup Derik Barseghian 11/06/2012 05:45 PM
5484 Kepler Bug Resolved Normal Module Manager GUI can fail to close and quit parent process David Welker 09/30/2011 10:55 PM
5473 Kepler Bug Resolved Normal 2.3.0rc1 won't start on Windows XP David Welker 09/30/2011 10:58 PM
5463 Kepler Bug Resolved Normal Provide security for Kepler databases Daniel Crawl 08/15/2011 02:18 PM
5456 Kepler Bug Resolved Normal Documentation for Reporting 2.3.0 Derik Barseghian 11/23/2011 02:53 PM
5455 Kepler Bug Resolved Normal Documentation for 2.3.0 Derik Barseghian 08/12/2011 06:21 PM
5446 Kepler Bug Resolved Normal View=>XML View broken David Welker 08/02/2011 04:25 PM
5442 Kepler Bug Resolved Normal View->Automate Layout doesn't work in kepler-2.3 branch David Welker 09/26/2011 05:34 PM
5441 Kepler Bug Resolved Normal no 'work will be lost' warning when accepting a patch via Module Manager David Welker 07/13/2011 02:22 PM
5440 Kepler Bug Resolved Normal special checkout behavior for hardcoded ptolemy module names jianwu jianwu 08/06/2012 12:07 PM
5437 Kepler Bug Resolved Normal provenance hsqgldb database doesn't behave as though it's properly shutdown when | Daniel Crawl 06/11/2012 04:06 PM
in server mode
5435 Kepler Bug New Normal passing string into a parameter for headless execution doesn't work David Welker 06/30/2011 04:53 PM
5434 Kepler Bug Resolved Normal run-kar result from headless kepler.sh execution doesn't contain report artifacts Derik Barseghian 06/30/2011 03:19 PM
5433 Kepler Bug Resolved Normal use 1024m instead of 512m for reporting suite Derik Barseghian 07/08/2011 03:37 PM
5430 Kepler Bug Resolved Normal problems with multiple instances of kepler Derik Barseghian 08/05/2011 07:59 AM
5429 Kepler Bug New Normal improve default provenance store performance Daniel Crawl 11/30/2011 12:59 PM
5424 Kepler Bug Resolved Normal see if it's worthwhile to upgrade hsql from 1.8 Daniel Crawl 02/05/2015 10:16 AM
5422 Kepler Bug Resolved Normal Tools=>Tag Manager... menu option is missing Sean Riddle 06/14/2011 06:48 PM
5420 Kepler Bug Resolved Normal Two types of NPE issues when 2.2.0 installed and run by a non-admin windows David Welker 06/13/2011 12:57 PM
user
5419 Kepler Bug Resolved Normal Cannot open KARs saved in 2.1.0 suites in 2.2.0 in relaxed mode because ptolemy | David Welker 07/13/2011 02:24 PM
module changed names
5417 Kepler Bug Resolved Normal changes to a sensor's serial-number param do not get written to config file Derik Barseghian 05/31/2011 01:48 PM
5413 Kepler Bug New Normal large run deletion via the WRM with hsgl provenance store takes a very long time Derik Barseghian 11/30/2011 12:54 PM
and no gui feedback
5404 Kepler Bug Resolved Normal change-sampling.kar demo no longer works Derik Barseghian 03/27/2012 07:49 PM
5402 Kepler Bug Resolved Normal Linux build at r27617 can't drag instantiate components David Welker 05/13/2011 03:58 PM
5396 Kepler Bug Resolved Normal rename ptolemy-8.1.0 module for the kepler 2.2 release David Welker 05/25/2011 04:44 PM
5380 Kepler Bug Resolved Normal Save As no longer disposes old window Aaron Aaron 04/26/2011 05:00 PM
5379 Kepler Bug Resolved Normal SPAN - add writing metadata changes to pending files Daniel Crawl 04/18/2011 02:03 PM
5378 Kepler Bug Resolved Normal add rety logic to SpanTodt, attempt to recover if RBNB goes down Derik Barseghian 06/14/2012 08:45 PM
5377 Kepler Bug New Normal DataTurbine actor fetch time outs (blockTimeout param not used?) Derik Barseghian 08/30/2012 05:34 PM
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5375 Kepler Bug Resolved Normal data not sent out after accumulating a large number of files in pending/ Derik Barseghian 04/05/2011 04:42 PM
5364 Kepler Bug New Normal DataTurbine server memory error Derik Barseghian 03/26/2012 01:03 PM
5363 Kepler Bug New Normal spanTodt performance Derik Barseghian 08/30/2012 05:34 PM
5360 Kepler Bug Resolved Normal changes to a sensor parameter might not take effect until next current sample Derik Barseghian 04/18/2011 03:39 PM
5359 Kepler Bug Resolved Normal SpanToDT NoClassDefFoundError Derik Barseghian 03/30/2011 10:36 AM
5358 Kepler Bug Resolved Normal CompositeActor name can disappear jilanwu jianwu 03/24/2011 05:32 PM
5357 Kepler Bug New Normal invocation problems with Distributed Composite Actor Options dialog jianwu jianwu 03/24/2011 06:12 PM
5355 Kepler Bug Resolved Normal actor documentation not included on instantiation Daniel Crawl 06/13/2012 07:06 PM
5347 Kepler Bug New Normal DataTurbine actor should support Start Time with sub-second accuracy Derik Barseghian 03/28/2011 03:51 PM
5341 Kepler Bug New Normal Belkin f5u409 usb=>serial dongle periodically stops working Derik Barseghian 08/30/2012 05:34 PM
5337 Kepler Bug Resolved Normal NPE from WorkflowManager when configuring actor within composite Derik Barseghian 03/04/2011 01:29 PM
5332 Kepler Bug Resolved Normal cr1k_d doesn't reliably connect to logger Derik Barseghian 04/12/2011 11:48 AM
5330 Kepler Bug New Normal Workflow Run Manager - include provenance trace file in run-kar Derik Barseghian 07/14/2011 12:28 PM
5329 Kepler Bug New Normal Workflow Run Manager - launch Provenance Browser from run-row Derik Barseghian 02/28/2011 06:50 PM
5328 Kepler Bug Resolved Normal 2.2rc2 - standalone module manager won't start David Welker 02/28/2011 09:25 PM
5326 Kepler Bug Resolved Normal 2.2rc2 - upgrade config file bug workaround moves KeplerData/modules to David Welker 05/24/2011 04:36 PM

KeplerData/modules.old instead of just configuration file dirs
5325 Kepler Bug Resolved Normal 2.2rc2 - documentation problems David Welker 02/28/2011 09:25 PM
5324 Kepler Bug Resolved Normal dcd_mgr buffer too small -- xxx Lost data.. messages Derik Barseghian 04/04/2011 09:48 AM
5323 Kepler Bug Resolved Normal saving Site Layout workflow makes Sensor actor parameters editable Daniel Crawl 03/03/2011 03:10 PM
5322 Kepler Bug Resolved Normal dcd_mgr crashes often Derik Barseghian 03/08/2011 02:43 PM
5321 Kepler Bug Resolved Normal sensor settings made by kepler user lost on SPAN restart Daniel Crawl 04/18/2011 03:40 PM
5318 Kepler Bug Resolved Normal 2.2.0 release testing David Welker 05/24/2011 05:05 PM
5315 Kepler Bug Resolved Normal Sensor Site view Components only filtered when All Ontologies and Folders Derik Barseghian 03/29/2011 03:22 PM
selected

5313 Kepler Bug New Normal fix Import Sensor Site and Export Site to KML menu item issues Derik Barseghian 03/27/2012 02:13 PM
5312 Kepler Bug Resolved Normal updating windowsXP installed 2.0.0 straight to 2.2.0 renders Kepler unable to start | David Welker 02/22/2011 01:23 PM
5311 Kepler Bug Resolved Normal 2.2.0rc1 - remote data sources don't work Jing Tao 02/17/2011 03:11 PM
5310 Kepler Bug Resolved Normal 2.2.0rc1 - Documentation link problems David Welker 02/24/2011 02:11 PM
5309 Kepler Bug Resolved Normal 2.2.0rc1 - Preferences and Components Search (configuration) issue David Welker 02/15/2011 10:32 PM
5307 Kepler Bug New Normal Report designer - fix drag and drop outline sizes Derik Barseghian 02/14/2011 02:31 PM
5306 Kepler Bug New Normal Report designer - make dynamic report item label textfields smaller Derik Barseghian 02/14/2011 02:24 PM
5305 Kepler Bug New Normal Report designer - make north and south dynamic item labels left justified Derik Barseghian 02/14/2011 02:21 PM
5304 Kepler Bug New Normal Report designer - make "+ Get Image..." button much smaller Derik Barseghian 02/14/2011 02:16 PM
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5302 Kepler Bug Resolved Normal module_dependencies column defined too short Daniel Crawl 06/21/2011 01:34 PM
5301 Kepler Bug Resolved Normal clicking on Image item Scale Property Value sometimes gives Derik Barseghian 02/14/2011 12:49 PM

ArraylndexOutOfBoundException
5299 Kepler Bug New Normal can't drag using report designer item icons Derik Barseghian 02/09/2011 12:25 PM
5298 Kepler Bug New Normal rendered west and east dynamic item label problems Derik Barseghian 02/09/2011 12:16 PM
5297 Kepler Bug Resolved Normal Workflow Run Manager - no indication of progress during preview runs download Derik Barseghian 02/08/2011 04:20 PM
5296 Kepler Bug Resolved Normal Workflow Run Manager - multiple window, remote store gui refresh issue Derik Barseghian 02/14/2011 05:56 PM
5295 Kepler Bug Resolved Normal Report designer panel gui simplification and spacing Derik Barseghian 02/08/2011 04:45 PM
5293 Kepler Bug Resolved Normal Deleting a report item scrolls you to top of design Derik Barseghian 02/11/2011 12:36 PM
5289 Kepler Bug In Progress Normal Change report instance margins from transparent to white Derik Barseghian 02/14/2011 02:27 PM
5285 Kepler Bug New Normal NPE on restart using newly created suite David Welker 01/31/2011 02:00 PM
5282 Kepler Bug Resolved Normal Documentation updates for 2.2 David Welker 01/31/2011 01:07 PM
5277 Kepler Bug Resolved Normal remove test servers from Sources preferences Derik Barseghian 01/28/2011 02:00 PM
5276 Kepler Bug New Normal component search performance is poor Jing Tao 08/19/2015 10:41 AM
5275 Kepler Bug Resolved Normal Executing sensor-view workflow records provenance Daniel Crawl 02/14/2011 01:45 PM
5274 Kepler Bug Resolved Normal Trying to schedule workflow with report layout puts up prompt about no report layout | Jing Tao 02/14/2011 01:45 PM
5268 Kepler Bug New Normal Dragging modified version of Sinewave actor to canvas causes gui oddity David Welker 01/05/2011 05:14 PM
5267 Kepler Bug New Normal Changing a ptolemy.kernel.util. Attribute in Kepler gui doesn't work David Welker 01/05/2011 05:04 PM
5266 Kepler Bug Resolved Normal Two empty boxes inside Sinewave actor and other icon problems for attributes Christopher Brooks 12/07/2012 10:39 AM
5260 Kepler Bug Resolved Normal Problems with unknown free-form tags Sean Riddle 01/12/2011 02:28 PM
5253 Kepler Bug Resolved Normal SpanToDT timestamp bug Daniel Crawl 04/12/2011 03:02 PM
5252 Kepler Bug In Progress Normal Plotting bugs Derik Barseghian 06/22/2012 04:31 PM
5251 Kepler Bug Resolved Normal using File->Open MoML... always opens model into Sensor Site view Sean Riddle 02/14/2011 01:45 PM
5248 Kepler Bug Resolved Normal downloading non-public kars from Search Components doesn't work Derik Barseghian 01/31/2011 06:20 PM
5247 Kepler Bug Resolved Normal Allow user to set memory allocated to Kepler from within Kepler Derik Barseghian 08/06/2012 03:29 PM
5237 Kepler Bug Resolved Normal Downloading kars on os X 10.6 locks Kepler Chad Berkley 11/10/2010 02:14 PM
5232 Kepler Bug Resolved Normal unable to open KARs saved beneath absent (e.g. third party) modules David Welker 01/28/2011 06:28 PM
5231 Kepler Bug Resolved Normal Tools => Preferences menu item gives error on trunk Derik Barseghian 10/28/2010 01:15 PM
5230 Kepler Bug Resolved Normal saving workflow that has instances of user created class to a KAR gives errors Chad Berkley 10/29/2010 10:23 AM
5219 Kepler Bug Resolved Normal problems when semantically annotating or tagging a composite actor Sean Riddle 01/14/2011 02:56 PM
5215 Kepler Bug Resolved Normal tags from a new ontology created within Tag Manager don't show up in Tagging Sean Riddle 10/27/2010 10:44 AM
drop-down
5212 Kepler Bug Resolved Normal deselecting ontologies in Tag Manager doesn't remove tags from Tagging Sean Riddle 10/27/2010 10:42 AM

drop-down
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5210 Kepler Bug New Normal Focus stolen from user trying to drag components around during execution Daniel Crawl 08/24/2012 01:59 PM
5208 Kepler Bug Resolved Normal Setting sensor sampling rate <1 causes errors Daniel Crawl 02/14/2011 01:45 PM
5207 Kepler Bug Resolved Normal Sensor changes color in response to configuring the actor even if no changes made | Daniel Crawl 02/14/2011 01:45 PM
5206 Kepler Bug Resolved Normal Importing or opening a sensor site doesn't open into the sensor site view Daniel Crawl 02/14/2011 01:45 PM
5205 Kepler Bug Resolved Normal Sensor site components not yet in tree Daniel Crawl 02/14/2011 01:45 PM
5204 Kepler Bug Resolved Normal kepler application menus on each kepler window instead of in mac menu bar David Welker 12/01/2010 06:22 PM
5200 Kepler Bug Resolved Normal WorkflowRun and Reporting artifacts no longer put into run-kars Derik Barseghian 11/03/2010 04:29 PM
5191 Kepler Bug Resolved Normal GUI improvements to Save As Derik Barseghian 01/05/2011 11:31 PM
5190 Kepler Bug Resolved Normal 6.0WorkingWithDatasets describes OPeNDAP but not DataTurbine actor Derik Barseghian 01/11/2011 02:00 PM
5187 Kepler Bug New Normal GUI should make apparent unsaved changes Chad Berkley 10/01/2010 12:54 PM
5186 Kepler Bug Resolved Normal Publish example KARs to repository Derik Barseghian 07/08/2011 06:33 PM
5185 Kepler Bug Resolved Normal common ontology_catalog.xml get modified Sean Riddle 09/29/2010 01:20 PM
5184 Kepler Bug Resolved Normal sanity check(s) when attempting to open owl file Sean Riddle 09/29/2010 01:21 PM
5183 Kepler Bug Resolved Normal Fix 6-WebServicesAndDataTransformation.xml jianwu jianwu 09/22/2010 05:33 PM
5182 Kepler Bug Resolved Normal documentation needs updating for 2.1 Derik Barseghian 09/28/2010 03:13 PM
5181 Kepler Bug Resolved Normal welcome window shows wrong version number Derik Barseghian 09/29/2010 01:13 PM
5180 Kepler Bug Resolved Normal Add a new Export File menu option that does a Save As (model xml) Derik Barseghian 09/16/2010 05:29 PM
5179 Kepler Bug Resolved Normal determine if ptolemy 8.0.0 is the desired version for kepler 2.1.0 release Christopher Brooks 09/28/2010 03:21 PM
5178 Kepler Bug Resolved Normal Documentation links are broken in help doc-index.html Derik Barseghian 09/28/2010 03:13 PM
5175 Kepler Bug New Normal Fix remaining issues with exporting multiple runs into one KAR Derik Barseghian 09/13/2010 12:14 PM
5165 Kepler Bug Resolved Normal implement a GUI Save action for KARs Derik Barseghian 09/28/2010 03:13 PM
5164 Kepler Bug Resolved Normal Don't show Workflow Run Manager and tag workflow drop-down list on Schedule Derik Barseghian 02/14/2011 01:45 PM

tab of Workflow Scheduler view

5161 Kepler Bug Resolved Normal can't always use Module Manager to change to an older patch of a suite David Welker 09/15/2010 11:57 PM
5160 Kepler Bug Resolved Normal problem changing suites using Module Manager David Welker 08/25/2010 12:36 PM
5158 Kepler Bug Resolved Normal remaining provenance issues for 2.1 release Daniel Crawl 06/21/2011 03:41 PM
5153 Kepler Bug New Normal Save As... closes all windows associated with a workflow Derik Barseghian 08/23/2015 02:26 PM
5145 Kepler Bug Resolved Normal kepler library skin is mostly broken Jing Tao 09/15/2010 05:46 PM
5143 Kepler Bug Resolved Normal not getting prompted to upgrade to available patched version in test area David Welker 08/20/2010 12:23 AM
5129 Kepler Bug In Progress Normal adding and removing configuration properties could be made easier Derik Barseghian 03/19/2013 03:59 PM
5101 Kepler Bug Resolved Normal Composite Actor windows show wrong title after workflow Rename Aaron Aaron 01/04/2011 11:53 PM
5100 Kepler Bug Resolved Normal Report Layout designed in a composite actor window is lost Derik Barseghian 07/22/2010 06:35 PM
5099 Kepler Bug Resolved Normal Import Dependent Modules for KAR doesn't work Derik Barseghian 08/25/2010 05:03 PM
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5097 Kepler Bug Resolved Normal kepler.sh accepts a limited number of arguments jianwu jianwu 08/05/2010 03:52 PM
5096 Kepler Bug Resolved Normal Reporting on a RecordToken fails Derik Barseghian 08/02/2010 10:57 AM
5091 Kepler Bug Resolved Normal Dragging and dropping report layout items NPEs Derik Barseghian 06/20/2011 04:25 PM
5090 Kepler Bug New Normal Report Layout interface is confusing wrt locking and switching to old layouts Derik Barseghian 07/07/2011 01:30 PM
5088 Kepler Bug Resolved Normal Report designer gui difficult to use with greater than about 3-4 items Derik Barseghian 02/03/2011 05:09 PM
5087 Kepler Bug Resolved Normal Image report items aren't shown when original image path doesn't resolve Derik Barseghian 01/03/2011 12:19 PM
5086 Kepler Bug New Normal Report instance does not show in viewer after kar open Derik Barseghian 07/09/2010 01:15 PM
5083 Kepler Bug Resolved Normal possible to save a kar that loses the report layout Derik Barseghian 02/11/2011 12:30 PM
5062 Kepler Bug Resolved Normal create bugs, mockups, eng view page updates showing how authentication will Derik Barseghian 02/14/2011 01:45 PM

work
5061 Kepler Bug Resolved Normal Report Design Panel needs fixing wrt event listening Derik Barseghian 01/31/2011 06:05 PM
5051 Kepler Bug Resolved Normal Semantically annotate during Save Archive a workflow with remote data set Error Chad Berkley 07/07/2010 10:45 AM
5050 Kepler Bug Resolved Normal Automatically filter workflow run manager runs based on selected workflow Derik Barseghian 02/14/2011 01:45 PM
5049 Kepler Bug Resolved Normal Prompt for credentials when connecting to remote kepler server Derik Barseghian 02/14/2011 01:45 PM
5045 Kepler Bug In Progress Normal Add a menu to add and configure new remote kepler servers Derik Barseghian 03/28/2011 05:10 PM
5044 Kepler Bug Resolved Normal Can't insert null record using Database Writer actor Derik Barseghian 06/08/2010 05:25 PM
5043 Kepler Bug Resolved Normal Help => Modules Documentation menu not in 2.0 debi staggs 06/11/2010 10:53 AM
5033 Kepler Bug Resolved Normal Workflow Run Manager - Allow multiple instances of WRM in one Kepler instance Derik Barseghian 02/14/2011 01:45 PM
5032 Kepler Bug Resolved Normal Workflow Run Manager - ability to connect to different prov stores from gui actions | Derik Barseghian 02/14/2011 01:45 PM
5030 Kepler Bug New Normal RExpression2 actor will fail if the libs are not found ben leinfelder 05/27/2010 02:14 PM
5018 Kepler Bug New Normal Items with the same LSID show with the same name in the Components Library Chad Berkley 05/19/2010 04:36 PM
5017 Kepler Bug Resolved Normal ReportLayout LSID and referral list should be maintained Derik Barseghian 02/01/2011 03:06 PM
5015 Kepler Bug Resolved Normal Export of runs contain different, and missing or extra reporting items now Derik Barseghian 05/19/2010 04:37 PM
5010 Kepler Bug Resolved Normal 2.0 branch fails to launch on XP - tries to compile apple-extensions-2.0 Derik Barseghian 05/14/2010 02:05 PM
5006 Kepler Bug Resolved Normal create and copy demo dir directory into KeplerData on startup if doesn't exist Derik Barseghian 05/13/2010 02:54 PM
4998 Kepler Bug Resolved Normal DataTurbine actor instantiation problem Derik Barseghian 05/10/2010 04:13 PM
4988 Kepler Bug Resolved Normal Instantiating a wf as a composite that has a tag doesn't work as expected Sean Riddle 01/14/2011 02:47 PM
4986 Kepler Bug Resolved Normal Problem with property DEMODIR on Windows XP Derik Barseghian 05/13/2010 02:54 PM
4985 Kepler Bug Resolved Normal problem with workflows using Rexpression on Windows XP Derik Barseghian 05/26/2010 03:08 PM
4981 Kepler Bug In Progress Normal RIO pdfs don't show up in the Component Library Derik Barseghian 02/04/2011 03:26 PM
4980 Kepler Bug Resolved Normal Tagging a run now creates two identical tags in the GUI Sean Riddle 05/06/2010 12:10 PM
4979 Kepler Bug Resolved Normal ROML has type of Reportinstance instead of ReportLayout in kar manifest Derik Barseghian 05/05/2010 12:22 PM
4977 Kepler Bug Resolved Normal Can't associate multiple sets of reporting artifacts in one kar with different Derik Barseghian 05/19/2010 02:59 PM
executions
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4976 Kepler Bug Resolved Normal Importing run archive from a different namespace is broken Derik Barseghian 05/06/2010 02:02 PM
4973 Kepler Bug Resolved Normal Save Archive sometimes saves more or less than it should in WRP Derik Barseghian 05/17/2010 01:56 PM
4972 Kepler Bug Resolved Normal Write documentation for workflow-run-manager module Derik Barseghian 05/26/2010 01:35 PM
4969 Kepler Bug Resolved Normal Exported run-kar puts a roml at root of Components tree Derik Barseghian 05/19/2010 04:22 PM
4967 Kepler Bug Resolved Normal Disallow dragging romls, workflowRuns, etc onto canvas Aaron Aaron 07/14/2011 12:22 PM
4965 Kepler Bug Resolved Normal Create and use configuration parameter for writing run-kars Derik Barseghian 04/29/2010 06:23 PM
4964 Kepler Bug Resolved Normal Provenance turns off for unsupported director, but doesn't send toggle event Daniel Crawl 04/29/2010 05:29 PM
4960 Kepler Bug Resolved Normal NPE from TableSorter when repeatedly executing a small workflow in WRP Derik Barseghian 04/28/2010 04:26 PM
4959 Kepler Bug Resolved Normal Reporting call to getDefaultProvenaceRecorder occasionally gets an NPE Derik Barseghian 04/26/2010 05:08 PM
4958 Kepler Bug Resolved Normal Tags colors are all white by default under Windows XP with Java 1.5 Sean Riddle 04/27/2010 02:00 PM
4955 Kepler Bug Resolved Normal Error trying to instantiate workflow from Outline tab Aaron Aaron 04/26/2010 02:21 PM
4954 Kepler Bug Resolved Normal Duration value on imported runs is incorrect Derik Barseghian 04/21/2010 11:41 AM
4953 Kepler Bug In Progress Normal Remote Components category sticks around sometimes Derik Barseghian 08/17/2015 08:56 AM
4952 Kepler Bug Resolved Normal Error recording workflow structure on workflow after deleting run Daniel Crawl 04/21/2010 01:45 PM
4944 Kepler Bug Resolved Normal Unsaved report warning happens once per window Derik Barseghian 04/26/2010 05:26 PM
4938 Kepler Bug Resolved Normal Reporting suite no longer works on its own Derik Barseghian 05/11/2010 05:01 PM
4937 Kepler Bug Resolved Normal Workflow tags showing as deletable in Tagging when clicking on Run Sean Riddle 04/13/2010 12:32 PM
4933 Kepler Bug New Normal Improve solution to avoid ConcurrentModificationException when tagging more than | Derik Barseghian 06/20/2011 04:27 PM

1run

4931 Kepler Bug Resolved Normal 'Refresh (using current layout)' button gives error when Provenance is off Derik Barseghian 04/15/2010 02:27 PM
4927 Kepler Bug Resolved Normal Don't allow export, upload, delete of executing run in WRM Derik Barseghian 04/14/2010 05:38 PM
4925 Kepler Bug Resolved Normal Components search occasionally shows different results Aaron Aaron 04/12/2010 01:16 PM
4924 Kepler Bug Resolved Normal Tagging a run when provenance is off gives errors Derik Barseghian 04/15/2010 01:11 PM
4919 Kepler Bug New Normal tag removal sends two tagRemoved events through provenance Sean Riddle 04/12/2010 01:31 PM
4916 Kepler Bug Resolved Normal Save Archive gives an error Aaron Aaron 04/05/2010 05:03 PM
4915 Kepler Bug Resolved Normal PortParameters instantiated from Outline tab cannot be deleted Derik Barseghian 05/12/2010 04:46 PM
4914 Kepler Bug Resolved Normal right-clicking on any item in Outline view gives exceptions Aaron Aaron 03/30/2010 01:32 PM
4912 Kepler Bug Resolved Normal File => New Workflow => FSM Model and Modal Model don't work Sean Riddle 04/14/2010 04:02 PM
4898 Kepler Bug Resolved Normal WorkflowRun entityld Isid no longer incrementing after getting tagged Derik Barseghian 03/31/2010 04:58 PM
4897 Kepler Bug New Normal Arrow key navigation of Workflow Run Manager can stop working Derik Barseghian 04/26/2010 03:44 PM
4896 Kepler Bug Resolved Normal When exporting multiple runs only 1 ROML is placed in KAR debi staggs 05/14/2010 02:24 PM
4895 Kepler Bug Resolved Normal Exporting multiple runs gives duplicate entry errors Derik Barseghian 03/31/2010 05:57 PM
4888 Kepler Bug Resolved Normal Runs with 1 error don't highlight red in WRM Aaron Aaron 03/18/2010 04:21 PM
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4858 Kepler Bug Resolved Normal Open Actor on non-composite actors no longer works David Welker 03/10/2010 04:17 AM
4852 Kepler Bug Resolved Normal Documentation => Remove Customization doesn't work Derik Barseghian 03/12/2010 01:40 PM
4848 Kepler Bug Resolved Normal only first change to Customize Documentation shown in Documentation=>Display Derik Barseghian 03/11/2010 04:37 PM
4847 Kepler Bug Resolved Normal Instantiating new actor from library gives error after restart Aaron Aaron 03/12/2010 01:57 PM
4829 Kepler Bug New Normal User log4j files Derik Barseghian 02/23/2010 06:22 PM
4800 Kepler Bug Resolved Normal CacheManager can not insert WorkflowRun into cache Derik Barseghian 03/30/2010 07:01 PM
4793 Kepler Bug Resolved Normal Workflow Run Manager - clicking on row when provenance is off gives error Derik Barseghian 04/02/2010 12:29 PM
4791 Kepler Bug Resolved Normal Actor names no longer have spaces Aaron Aaron 02/12/2010 03:16 PM
4784 Kepler Bug Resolved Normal Remove or fix and re-enable the fullscreen zoom button debi staggs 02/10/2010 05:34 PM
4766 Kepler Bug Resolved Normal Semantic Annotation Editor doesn't close when you click the close button on mac Derik Barseghian 02/11/2010 07:13 PM
4765 Kepler Bug Resolved Normal semantic annotation doesn't appear until you click on workflow Sean Riddle 04/21/2010 03:16 PM
4736 Kepler Bug New Normal RFE speed up Suggest Similar Components feature Derik Barseghian 02/04/2010 02:28 PM
4731 Kepler Bug Resolved Normal Documentation Customize on directors and parameters gives ClassCastException | Aaron Aaron 02/04/2010 03:54 PM
4713 Kepler Bug Resolved Normal Eclipse build still broken David Welker 01/29/2010 04:18 PM
4697 Kepler Bug Resolved Normal Semantic Annotation does not increment LSID revision Derik Barseghian 02/09/2010 02:01 PM
4696 Kepler Bug Resolved Normal Title bar doesn't refresh after rename during Save Archive Derik Barseghian 02/04/2010 01:59 PM
4694 Kepler Bug Resolved Normal workflow run manager - differentiate imported runs Derik Barseghian 01/03/2011 12:03 PM
4693 Kepler Bug In Progress Normal Ability to save just a report instance Derik Barseghian 07/14/2011 12:33 PM
4689 Kepler Bug Resolved Normal Export run creates duplicate WorkflowRun files. Exporting it again gives none. Derik Barseghian 03/24/2010 11:15 AM
4681 Kepler Bug Resolved Normal Check all file properties before release Chad Berkley 04/28/2010 01:25 PM
4674 Kepler Bug New Normal WorkflowRunManager search cells are catching tab keys wherever they occur Derik Barseghian 01/14/2010 06:02 PM
4673 Kepler Bug Resolved Normal past runs with workflows that get renamed don't reflect this Derik Barseghian 01/26/2010 05:21 PM
4672 Kepler Bug Resolved Normal Workflow title isn't refreshed during run export workflow rename Derik Barseghian 04/15/2010 02:51 PM
4663 Kepler Bug Resolved Normal Tag shows up in workflow moml when it shouldn't Sean Riddle 03/30/2010 06:13 PM
4659 Kepler Bug Resolved Normal Importing run gives a ClassCastException Derik Barseghian 01/13/2010 04:24 PM
4619 Kepler Bug Resolved Normal WorkflowRuns not showing inside KARs in library Derik Barseghian 03/31/2010 05:59 PM
4618 Kepler Bug Resolved Normal First export of a run doesn't yield KAR with ROML Derik Barseghian 01/05/2010 09:43 AM
4607 Kepler Bug Resolved Normal Workflow Run Manager - opening kar no longer adds run-row Derik Barseghian 12/14/2009 05:32 PM
4606 Kepler Bug Resolved Normal Workflow Run Manager - using CAPS in tags search doesn't work Derik Barseghian 12/07/2009 04:11 PM
4605 Kepler Bug Resolved Normal Semantic Annotation NPE Aaron Aaron 12/14/2009 03:59 PM
4590 Kepler Bug Resolved Normal Workflow Run Manager - Export Archive can give error Aaron Aaron 12/14/2009 05:32 PM
4589 Kepler Bug New Normal Workflow Run Manager - tagging causes row(s) to unhighlight Derik Barseghian 01/13/2010 02:22 PM
4586 Kepler Bug Resolved Normal problem tagging all rows when selected with keyboard Derik Barseghian 11/30/2009 05:37 PM
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4580 Kepler Bug Resolved Normal Error saving/opening KAR that has a workflow with a PortParameter Daniel Crawl 02/11/2010 01:49 PM
4578 Kepler Bug Resolved Immediate tracking bug for changes to .kepler Derik Barseghian 02/23/2010 09:46 AM
4577 Kepler Bug New Normal integrate, and separate from save/export, the code for Uploading Derik Barseghian 02/11/2010 04:32 PM
4574 Kepler Bug Resolved Normal Able to delete workflow tags when on a run Sean Riddle 11/24/2009 04:12 PM
4566 Kepler Bug Resolved Normal Workflow Run Manager - highlighting sometimes doesn't work for multiple rows Derik Barseghian 11/20/2009 02:56 PM
4555 Kepler Bug Resolved Normal error exporting etc >1 run with same name but different wf Derik Barseghian 11/19/2009 11:47 AM
4552 Kepler Bug Resolved Normal Workflow Run Manager Export Archive no longer adding to Library Derik Barseghian 11/16/2009 03:13 PM
4546 Kepler Bug Resolved Normal Save Archive on an actor quits Kepler ben leinfelder 11/18/2009 10:05 AM
4544 Kepler Bug Resolved Normal Enter key in Report Designer title invokes a search Derik Barseghian 02/02/2011 05:13 PM
4541 Kepler Bug Resolved Normal problem exporting run debi staggs 11/13/2009 07:27 PM
4539 Kepler Bug Resolved Normal Applying a tag can be slow Derik Barseghian 11/10/2009 02:39 PM
4538 Kepler Bug Resolved Normal problems with KARs that contain tags from default ontologies Sean Riddle 01/27/2010 04:21 PM
4518 Kepler Bug Resolved Normal Workflow Run Manager - no imported run tags Derik Barseghian 01/13/2010 02:47 PM
4509 Kepler Bug Resolved Normal Report instance not being serialized with Save Archive ben leinfelder 10/28/2009 03:30 PM
4505 Kepler Bug Resolved Normal NPE from Semantic Search Derik Barseghian 01/13/2010 06:38 PM
4504 Kepler Bug Resolved Normal Semantic Type Browser Sean Riddle 10/28/2009 11:07 AM
4503 Kepler Bug Resolved Normal Suggest Similar Components gives an error Shawn Bowers 02/04/2010 02:25 PM
4479 Kepler Bug Resolved Normal Error messages are not imported during run import Derik Barseghian 01/25/2010 11:06 AM
4476 Kepler Bug Resolved Normal Tagging / Workflow Run Manager interaction problems Sean Riddle 11/02/2009 01:32 PM
4458 Kepler Bug New Normal test for moving kepler directory Derik Barseghian 02/11/2010 04:33 PM
4457 Kepler Bug Resolved Immediate Workflow Run Manager - past Report Layouts don't open ben leinfelder 11/18/2009 11:48 AM
4456 Kepler Bug Resolved Normal Workflow Run Manager in Report Viewer Derik Barseghian 02/12/2010 11:49 AM
4455 Kepler Bug Resolved Normal provenance schema must meet tag storage and search needs Derik Barseghian 11/24/2009 04:19 PM
4454 Kepler Bug Resolved Normal Workflow Run Manager - ability to display new run tags Derik Barseghian 11/30/2009 04:19 PM
4453 Kepler Bug Resolved Normal tags don't show up in snow leopard (10.6) Sean Riddle 01/05/2010 10:05 AM
4446 Kepler Bug Resolved Normal serialized workflowRuns should have use a date standard Derik Barseghian 10/12/2009 01:11 PM
4443 Kepler Bug Resolved Normal gui-free class for provenance store settings Derik Barseghian 04/12/2011 03:01 PM
4438 Kepler Bug Resolved Normal View: label shouldn't appear when there's no view drop-down menu Derik Barseghian 01/14/2010 04:37 PM
4434 Kepler Bug New Normal Workflow Run Manager - add ability to hide/show columns Derik Barseghian 01/13/2010 02:19 PM
4431 Kepler Bug New Normal Export Archive actions should share code where possible Derik Barseghian 01/13/2010 02:31 PM
4425 Kepler Bug Resolved Normal problem with Open Archive with run KAR created in same session Derik Barseghian 09/30/2009 03:37 PM
4424 Kepler Bug Resolved Normal KeplerLSID should implement hashCode Aaron Aaron 10/02/2009 05:08 PM
4419 Kepler Bug Resolved Normal KARFile openKARContents problem with open success Aaron Aaron 09/29/2009 05:35 PM
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4410 Kepler Bug Resolved Normal Cannot open KARs from arbitrary location on disk Aaron Aaron 11/18/2009 09:12 AM
4404 Kepler Bug New Normal DataTurbine actor - instantiating actor without internet gives error msg Derik Barseghian 01/13/2010 02:22 PM
4370 Kepler Bug Resolved Normal Changes to Components and Data Preferences disappear on relaunch Aaron Aaron 09/18/2009 03:35 PM
4362 Kepler Bug Resolved Normal component search performance Aaron Aaron 01/24/2010 04:23 PM
4355 Kepler Bug Resolved Normal unexpected workflow appears in provenance after WRM run deletion Derik Barseghian 09/01/2009 01:50 PM
4349 Kepler Bug Resolved Normal clicking Cancel after Data search gives errors. Derik Barseghian 10/06/2009 03:47 PM
4347 Kepler Bug Resolved Normal Reminder "bug" for manual testing before 2.0 release Chad Berkley 01/13/2010 03:51 PM
4346 Kepler Bug Resolved Normal Searching for Saved Archive (KAR) workflow in default workflow folder gives error | Aaron Aaron 10/02/2009 05:17 PM
4327 Kepler Bug New Normal Workflow Run Manager - ability to import run archives Derik Barseghian 04/26/2010 03:45 PM
4325 Kepler Bug Resolved Normal Workflow Run Manager - deleted runs sometimes reappear after Kepler relaunch Derik Barseghian 11/30/2009 05:49 PM
4313 Kepler Bug Resolved Normal Workflow Run Manager - duplicate rows shown for same execution Derik Barseghian 08/13/2009 02:03 PM
4308 Kepler Bug Resolved Normal Workflow Run Manager - problem with getWorkflowRunsForExecutions in mysql Daniel Crawl 09/18/2009 07:17 PM
4252 Kepler Bug Resolved Normal Workflow Run Manager - deleting a run before running a wf doesn't work Derik Barseghian 07/16/2009 11:12 AM
4251 Kepler Bug Resolved Normal Workflow Run Manager - wrong rows when operating on re-sorted table Derik Barseghian 07/31/2009 04:27 PM
4248 Kepler Bug Resolved Normal export dialogs should show default extension Derik Barseghian 08/28/2009 12:49 PM
4247 Kepler Bug Resolved Normal Application menu items sometimes disappear on OS X Derik Barseghian 06/20/2011 04:00 PM
4231 Kepler Bug Resolved Normal Workflow Run Manager - failed runs should be highlighted red Derik Barseghian 04/19/2010 05:38 PM
4230 Kepler Bug Resolved Normal problem associating errors with particular execution Daniel Crawl 04/15/2010 02:44 PM
4229 Kepler Bug Resolved Normal rename runs with untitled workflow name when the user does a Save Daniel Crawl 07/09/2009 07:21 PM
4171 Kepler Bug Resolved Normal dragging actor to canvas then back to component tree area gives NPE Derik Barseghian 12/27/2009 09:23 AM
4151 Kepler Bug Resolved Normal exported RIO and ROML doc run-pairs have same KeplerLSID ben leinfelder 06/24/2009 11:45 AM
4150 Kepler Bug Resolved Immediate Save in Library broken Aaron Aaron 12/02/2009 01:00 PM
4149 Kepler Bug Resolved Normal Workflow Run Manager - Export Runs feature Derik Barseghian 06/25/2009 01:19 PM
4148 Kepler Bug Resolved Normal Workflow Run Manager - Upload to Repository feature Derik Barseghian 06/26/2009 10:29 AM
4144 Kepler Bug Resolved Normal Workflow Run Manager - moving columns / new windows bug Derik Barseghian 06/15/2009 11:37 AM
4140 Kepler Bug Resolved Normal Workflow Run Manager - delete runs functionality needs to be written Derik Barseghian 08/20/2009 05:11 PM
4138 Kepler Bug New Normal Workflow Run Manager - search cell edit focus isn't lost appropriately Derik Barseghian 08/31/2009 05:07 PM
4137 Kepler Bug New Normal Workflow Run Manager - resizing width of column while in edit mode of search cell | Derik Barseghian 08/31/2009 05:06 PM

does not resize edit field
4136 Kepler Bug Resolved Normal Workflow Run Manager - date and duration search should allow single operator-less | Derik Barseghian 02/04/2011 03:19 PM
arguments

4135 Kepler Bug Resolved Normal Workflow Run Manager - default sorting (by date) should be applied Derik Barseghian 08/07/2009 03:48 PM
4134 Kepler Bug Resolved Normal Workflow Run Manager - double clicking on search cell shouldn't sort column Derik Barseghian 08/07/2009 06:24 PM
4133 Kepler Bug Resolved Normal Workflow Run Manager - column widths should be size appropriately Derik Barseghian 07/08/2009 06:02 PM
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4132 Kepler Bug New Normal Workflow Run Manager - Open in New Window is just opening the workflow, not the | Derik Barseghian 11/13/2009 07:23 PM
ROML or report
4131 Kepler Bug New Normal Workflow Run Manager - Open in New Window allows opening same wf multiple Derik Barseghian 08/31/2009 05:06 PM
times

4094 Kepler Bug Resolved Normal new Unnamed windows should have a suffix that increments Derik Barseghian 07/09/2009 11:21 AM
4092 Kepler Bug Resolved Normal record all files referred to in array tokens Derik Barseghian 05/21/2009 01:20 PM
4054 Kepler Bug Resolved Normal DataTurbine tree actor icon should be a can Derik Barseghian 05/04/2009 05:46 PM
4050 Kepler Bug Resolved Normal dragging actors can leave artifacts until you stop dragging Derik Barseghian 05/04/2009 03:40 PM
4049 Kepler Bug New Normal Import actor that already exists appends strange numbering scheme Derik Barseghian 07/03/2013 04:56 PM
4047 Kepler Bug Resolved Normal Remove Component doesn't work Derik Barseghian 07/14/2011 12:26 PM
4022 Kepler Bug Resolved Normal undesired file:\ prefix added by FileParameter Derik Barseghian 08/04/2009 12:31 AM
4009 Kepler Bug Resolved Immediate kepler 2.0 must provide everything needed for modules David Welker 02/05/2010 12:51 PM
3943 Kepler Bug New Normal error importing more than one actor created in one suite using kepler-1.0 Chad Berkley 04/08/2009 11:39 AM
3932 Kepler Bug Resolved Normal Configure Actor actor context menu item missing Chad Berkley 04/30/2009 04:54 PM
3930 Kepler Bug New Normal error importing hello-world tutorial actor into kepler-1.0 suite Chad Berkley 04/03/2009 03:18 PM
3917 Kepler Bug Resolved Normal refactor schema creation code out of recording classes Daniel Crawl 04/27/2009 10:17 AM
3900 Kepler Bug Resolved Normal leaving fullscreen mode gives an NPE and closes window Chad Berkley 04/22/2009 03:48 PM
3771 Kepler Bug Resolved Normal ant update error David Welker 01/22/2009 03:17 PM
3770 Kepler Bug Resolved Normal CompositeActor "Open Actor" menu item is missing Christopher Brooks 03/13/2009 07:21 PM
3769 Kepler Bug Resolved Normal Problem with DistributedCompositeActor jilanwu jianwu 01/22/2009 03:01 PM
3766 Kepler Bug New Normal Improve menu options in text editor Derik Barseghian 04/03/2009 03:18 PM
3764 Kepler Bug Resolved Normal Kepler needs to support EML 2.1.0 ben leinfelder 05/22/2009 10:24 AM
3738 Kepler Bug Resolved Normal File -> Save As menu item is missing David Welker 01/27/2009 05:50 PM
3723 Kepler Bug Resolved Normal all actors appear in the same upper-left position when dragged onto canvas Chad Berkley 01/06/2009 02:57 PM
3722 Kepler Bug Resolved Normal parameters cannot be dragged onto the canvas Chad Berkley 01/07/2009 04:12 PM
3708 Kepler Bug Resolved Normal Case actor issues Derik Barseghian 07/17/2009 11:47 AM
3706 Kepler Bug New Normal Add "Open the container" toolbar button Derik Barseghian 04/03/2009 03:27 PM
3705 Kepler Bug New Normal some actor icons don't denote that they are a composite Derik Barseghian 04/03/2009 03:26 PM
3691 Kepler Bug Resolved Immediate JButton labels truncated on macOSX Derik Barseghian 05/19/2009 05:57 PM
3683 Kepler Bug Resolved Normal add tokenType to token_flow table in provenance sql schema Daniel Crawl 04/03/2009 04:47 PM
3656 Kepler Bug Resolved Normal create a Provenance Client Derik Barseghian 11/24/2009 12:01 PM
3655 Kepler Bug New Normal create a Workflow Run Manager with ability to export Publication Ready Archives Derik Barseghian 08/31/2009 05:08 PM
3652 Kepler Bug New Normal Ensure all Provenance Recording Types record the same things Derik Barseghian 04/03/2009 03:18 PM
3649 Kepler Bug Resolved Normal determine if Provenance has everything needed by Reporting Derik Barseghian 11/23/2009 04:50 PM
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3606 Kepler Bug Resolved Normal ProvenanceRecorder config actor menus Derik Barseghian 04/20/2009 12:01 PM
3605 Kepler Bug Resolved Normal problem with ProvenanceRecorder Daniel Crawl 04/21/2009 09:50 AM
3595 Kepler Bug New Normal Exporting an actor should prompt user to semantically annotate it if it's not already | Derik Barseghian 04/03/2009 03:25 PM
3593 Kepler Bug Resolved Normal exporting an actor to kar does not save portparameters that have been defined Derik Barseghian 05/04/2009 12:42 PM
3577 Kepler Bug New Normal FilterUl actor has problems Derik Barseghian 04/03/2009 03:18 PM
3542 Kepler Bug Resolved Normal Tree View menu is too wide when opened Derik Barseghian 04/03/2009 03:06 PM
3531 Kepler Bug New Normal Save As dialog inconsistent between linux and mac Derik Barseghian 04/03/2009 02:45 PM
3451 Kepler Bug Resolved Normal RExpression actor can get typing wrong for incoming numeric vector /array on first | Derik Barseghian 07/14/2008 02:48 PM

workflow run

3443 Kepler Bug Resolved Normal Rexpression actor, relation vs multiport and port type resolution Derik Barseghian 07/09/2008 05:35 PM
3440 Kepler Bug New Normal add Up and Down buttons to change port order on an actor Derik Barseghian 04/03/2009 02:45 PM
3363 Kepler Bug Resolved Normal Show name checkbox does nothing for most Parameters Christopher Brooks 04/25/2009 12:25 PM
3361 Kepler Bug In Progress Normal parameters lose their Display Name when copy and pasted Derik Barseghian 04/03/2009 02:18 PM
3349 Kepler Bug Resolved Normal RExpression getUniqueFileName functionality is broken Derik Barseghian 05/30/2008 01:34 PM
3339 Kepler Bug Resolved Normal directory param Browse button for External Execution actor doesn't work properly Derik Barseghian 12/04/2008 02:02 PM
3332 Kepler Bug Resolved Normal RExpression_Matrix_IO_Test workflow gives an error ben leinfelder 04/29/2009 05:16 PM
3324 Kepler Bug Resolved Normal RExpression actor doesn't output properly with >1 dataframe output port Derik Barseghian 05/29/2008 03:56 PM
3312 Kepler Bug Resolved Normal DataTurbine (formerly RBNBToKepler) actor - error with empty server Derik Barseghian 09/24/2008 10:13 AM
3295 Kepler Bug New Normal Python/Ptolemnizer welcome text does not display Derik Barseghian 04/03/2009 02:18 PM
3292 Kepler Bug New Normal ENM/GDAL_h1K_NS workflow giving an exception Chad Berkley 04/03/2009 02:18 PM
3276 Kepler Bug Resolved Normal MatlabExpression not finding ptmatlab.dylib Daniel Crawl 05/06/2008 02:02 PM
3275 Kepler Bug New Normal EML200DataSource interface Derik Barseghian 04/03/2009 02:18 PM
3270 Kepler Bug Resolved Normal disable DIGIR Data Source by default ben leinfelder 05/09/2008 11:07 AM
3268 Kepler Bug Resolved Normal Python/PythonFileLineCounter.xml workflow problem Chad Berkley 05/07/2008 06:01 PM
3267 Kepler Bug Resolved Normal ENM/GARP_SingleSpecies_BestRuleSet-1V.xml problems Chad Berkley 05/07/2008 09:59 PM
3266 Kepler Bug In Progress Normal ENM/GARP_MultipleSpecies-V.xml problems Chad Berkley 04/03/2009 02:18 PM
3264 Kepler Bug Resolved Normal workflow ENM/ASC2RAWTest gives an exception under ubuntu Chad Berkley 05/07/2008 04:19 PM
3261 Kepler Bug Resolved Normal ApplicationFramework/CredentialRetrieve workflow has problems Chad Berkley 05/07/2008 04:09 PM
3235 Kepler Bug New Normal Add an Edit, Select All menu item and respective accelerator Derik Barseghian 04/03/2009 02:18 PM
3221 Kepler Bug New Normal offset new windows Derik Barseghian 04/03/2009 02:18 PM
3215 Kepler Bug Resolved Normal Spaces in KEPLER path causes build problems Chad Berkley 04/11/2008 11:16 AM
3203 Kepler Bug Resolved Normal Add dateType Derik Barseghian 06/05/2008 11:33 AM
3161 Kepler Bug New Normal progress meter when downloading data with RBNBToKepler actors Derik Barseghian 04/20/2009 10:44 AM
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3160 Kepler Bug New Normal RBNBToKepler actors should work within SDF, PN and DDF Derik Barseghian 04/03/2009 02:18 PM
3159 Kepler Bug Resolved Normal RBNBToKepler datasource actors should be merged into one. Derik Barseghian 09/26/2008 12:16 PM
3158 Kepler Bug New Normal RBNBToKepler actors need to timeout more quickly Derik Barseghian 04/03/2009 02:18 PM
3157 Kepler Bug Resolved Normal RBNBToKepler actors should support all three sink modes Derik Barseghian 09/26/2008 12:29 PM
3156 Kepler Bug Resolved Normal RBNBToKepler actors should only download data for connected ports. Derik Barseghian 09/26/2008 12:30 PM
3155 Kepler Bug Resolved Normal RBNBToKepler actors should allow different output formats Derik Barseghian 09/26/2008 12:18 PM
3143 Kepler Bug New Normal dataFrame_R cache problem under parallels Chad Berkley 04/03/2009 02:18 PM
3140 Kepler Bug Resolved Normal RBNBToKepler2 actor output port generation problem Derik Barseghian 04/14/2008 03:01 PM
3130 Kepler Bug Resolved Normal Add an accelerator (keyboard shortcut) for opening a new blank workflow Derik Barseghian 04/15/2008 02:51 PM
2889 Kepler Bug Resolved Normal fileName in ConfigXML.java not getting set Derik Barseghian 12/13/2007 02:18 PM
2872 Kepler Bug Resolved Normal md5 checksums Chad Berkley 05/12/2008 12:31 PM
5698 Metacat Bug New Normal datapackage uploads to dev2 metacat are currently slow Jing Tao 08/28/2012 03:45 PM
3938 REAP Bug New Normal simhofi workflow R actor problem Derik Barseghian 04/03/2009 01:46 PM
3839 REAP Bug New Normal improve aphidPanTrapVsGDD_BYDVstudy workflow Derik Barseghian 02/25/2009 11:37 AM
3677 REAP Bug New Normal document Baskett field data and upload into OSU metacat Derik Barseghian 04/20/2009 12:09 PM
3650 REAP Bug New Normal move MET station to McLaughlin and begin work on Engineering view Derik Barseghian 10/16/2009 10:37 AM
3365 REAP Bug New Normal Example workflow pulling data from SensorBase at CENS using WebService actor | Derik Barseghian 06/05/2008 12:27 PM
or DBQuery actor
3364 REAP Bug New Normal Complete PAR data acquisition workflow Derik Barseghian 09/26/2008 12:39 PM
5771 SciencePipes Bug New Normal Internet Explore 9 in Win7 doesn't save drop down parameter choices Derik Barseghian 12/13/2012 02:35 PM
5770 SciencePipes Bug New Normal Internet Explorer 9 in Win7 doesn't properly show the "Are you sure you want to Derik Barseghian 12/13/2012 02:33 PM
leave" dialog
5769 SciencePipes Bug Resolved Normal problem opening saved pipe with Bird Morphology Data in Firefox 17.1 Derik Barseghian 12/13/2012 01:51 PM
5765 SciencePipes Bug New Normal automatically determine whether to use Table or Raw view Derik Barseghian 12/11/2012 01:50 PM
5764 SciencePipes Bug New Normal move pipe Cache Time setting to Settings page Derik Barseghian 12/11/2012 12:55 PM
5730 SciencePipes Bug In Progress Normal allowDisconnectedGraphs is now always true for SP, documentation must be Derik Barseghian 11/07/2012 03:13 PM
updated
5729 SciencePipes Bug New Normal problems with parameter choices that end in whitespace Derik Barseghian 11/07/2012 03:04 PM
5481 SciencePipes Bug Resolved Normal create subclassed R actor that doesn't allow arbitrary scripts to be run Derik Barseghian 11/07/2012 02:38 PM
5480 SciencePipes Bug Resolved Normal create a 3rd data option in SciencePipes for graveyard demography data Derik Barseghian 11/04/2011 01:02 PM
5479 SciencePipes Bug New Normal protect against running injected MoMLs Derik Barseghian 08/30/2011 11:26 AM
5477 SciencePipes Bug New Normal leaving 'Execution engine status' page open can cause problems for apache Derik Barseghian 08/19/2011 05:38 PM
5476 SciencePipes Bug New Normal consolidate private data, and automatically fill it in Derik Barseghian 08/19/2011 05:32 PM
5472 SciencePipes Bug Resolved Normal Reset derik's CVS password Paul Allen 08/16/2011 01:52 PM
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5471 SciencePipes Bug Resolved Normal get package#1 datasets to Derik Derik Barseghian 08/16/2011 01:42 PM
5470 SciencePipes Bug Resolved Normal discuss which statistical techniques to use with Ken Paul Allen 11/07/2012 02:39 PM
5469 SciencePipes Bug Resolved Normal grant Derik admin access to SciencePipes sites Paul Allen 08/16/2011 01:36 PM
5468 SciencePipes Bug New Normal produce dynamic charts Derik Barseghian 11/07/2012 02:45 PM
5467 SciencePipes Bug Resolved Normal Tag CommunityServices and JobEngine in Cornell CVS Derik Barseghian 09/01/2011 02:11 PM
5466 SciencePipes Bug In Progress Normal remove any private data from SciencePipes codebase Derik Barseghian 08/29/2011 11:15 AM
5465 SciencePipes Bug New Normal make SciencePipes licensing compatible with Kepler Derik Barseghian 08/30/2011 11:40 AM
5464 SciencePipes Bug In Progress Normal move SciencePipes codebase to kepler repository Derik Barseghian 08/16/2011 12:46 PM
5246 SEEK Bug Resolved Normal HTTP response code: 500 when trying to upload large KAR through kepler Jing Tao 11/17/2010 04:11 PM
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